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CHAPTER 1: INTRODUCTION 

1.1 Welcome to ADePT 

Many programme over-runs and cost over-spends in complex projects are the result of 
design and engineering teams working with poorly co-ordinated design information. The 
‘ADePT’ technique and associated ADePT Design software suite are used to develop 
integrated design plans which ensure that designers are able to work together to generate a 
fully co-ordinated design. 

 

 

ADePT is a highly structured approach to planning, and subsequently managing, the design 
activities within a complex project. The approach is aimed at development of a design plan 
which is fully integrated across the design team members and based on the critical flows of 
information between them. Subsequent management of information flows is regarded as a 
much better way of controlling the design process than simply monitoring production of 
deliverables or rate of fee spend. There are three stages to planning with ADePT, and a 
further management stage. 

ADePT identifies a sequence of activities which minimises the iteration in the design process 
and ensures any assumptions which the team need to make are ones which can be made 
with confidence. This is achieved by weighting the dependencies between activities. The 
calculation of a sequence prioritises the availability of outputs associated with the most 
critical dependencies. Any interdependent, iterative groups of activities which remain in the 
process following sequencing are often multi-disciplinary. They represent places in the 
design process where design team members should work concurrently to solve the 
interdependent problem. Usually they also represent elements of the product, and 
therefore of the design output, which require co-ordination. 

Having produced a target design plan, the design process needs to be controlled. ADePT 
incorporates an approach to process control which pre-empts deviation from the target 
schedule by analysing constraints, which then allows the plan to be kept up-to-date and 
used in meaningful way. 

In Summary, the ADePT methodology and the ADePT Design software suite provides a means 
of planning, managing and controlling the delivery of a project on the basis of co-ordinated 
interdisciplinary working. There are many benefits to decision-makers from utilising this 
approach: the number of assumptions that cannot be made with confidence is minimised; 
risk and cost implications can be understood and subsequently managed; wasteful iteration 
can be eliminated; and focus can be given to taking interconnected decisions quickly and 
effectively. Ultimately, the approach offers a means of planning, controlling, and managing 
projects in an informed, coherent, and achievable manner. 
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1.2 Welcome to ADePT Design Manager 

ADePT Design Manager enables Project Managers, Design Managers and Planners to monitor 
and control project processes, which have been planned using ADePT Design Builder, by 
implementing the control stage of the ADePT technique. 

Complex project and business processes can be controlled by: 

• Agreeing a plan of work 

• Regularly reporting progress against an agreed plan 

• Ensuring tasks are fully completed in line with the agreed plan and not allowed to 
remain incomplete for longer than is necessary 

• Identifying reasons that tasks are unable to be completed 

• Identifying constraints on forthcoming tasks and taking action to remove those 
constraints 

• Ensuring the flow of information and documentation through a process is achieved in 
line with the agreed plan. 

 

1.3 About this user manual 

This user manual describes how each item of functionality in ADePT Design Manager is 
accessed and executed. Each section covers the reasons for the functionality (why), how it 
is executed, including any alternative methods (how), and any additional information. The 
document has been deliberately kept brief (for a user manual), with each section being 
presented as a series of brief steps supported by screen shots where necessary. 

Each section can be read in isolation. However the manual is laid out in the order that users 
should logically follow the functionality of the software, mirroring the steps of the ADePT 
methodology which the software enables. Therefore the user manual can also be used as a 
tutorial if necessary (although specific tutorial material is available). 

It is recommended that this user manual is used as a reminder, when needed, of the 
functionality in the software and that initial familiarisation with the software is achieved 
through the training which is available. 

 

1.3 The basics 

Before using this user manual it might be useful to familiarise yourself with the general 
layout of the software and the terms which are used throughout the manual which relate to 
layout.  

Firstly, the product adopts the latest layout advocated by Microsoft office products, which 
means that the File menu is not immediately obvious. It can be found by clicking on the 
circle containing the product icon at the top-left hand corner of the application. 

 

This style of layout works by selecting the appropriate ‘tab’ which in turn provides access to 
the tools required for the functionality being used. Sometimes you will need to select the 
correct tab and other times the tab will be selected automatically as you navigate through 
the software. There are three tabs in ADePT Design Builder: Manage Workplans, View 
Workplan, and Analyse Progress. 
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This layout means that useful functions like Save, Undo and Redo, Navigate Back and 
Forward, and Help (denoted by a question mark) are all available without the need to select 
a drop-down menu. 

Finally, when working with a Workplan, or with the tasks in a Workplan, the screen is split 
into two at all times, with the left-hand pane representing the Workplan or tasks and the 
right-hand pane representing either the tasks in a Workplan or the properties of a task: 
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CHAPTER 2: MANAGING A PROJECT FILE 

This chapter describes how to undertake basic tasks which allow you to manage a project file. 

2.1 Open an existing project file 

Why? 

Open a project file in order to create a Workplan or to continue work with an existing 
Workplan. 

How? 

1. Select Open from the File menu or pick a previously opened file from the list displayed.  

2. Select the desired file from the relevant location in your folder structure. 

3. Click on OK. 

 

2.2 Create a model file from an Asta Powerproject o r  Microsoft Project bar chart 

Why? 

Create a model file from an existing file in a third-party bar chart application. 

How? 

1. Select New from the File menu and define the project name and other characteristics. 

2. At Stage 1 of the Synchronise Project Wizard select the Change Connection [ ] symbol. 

3. Choose the relevant third-party application from the drop-down list and select OK 

4. Select Existing Project and select […] to locate the relevant file. 

5. Select OK 

6. Select Next 

7. At stage 2 of the Synchronise Project Wizard, select In from Microsoft Project or In from 
Asta Powerproject. 

8. Select Next 

9. At stage 3 of the Synchronise Project Wizard, highlight the changes to make to the ADePT 
model file using the tick boxes – usually leave all changes highlighted. 

10. Select Finish. 

 

2.3 Create a model file from a Primavera bar chart 

Why? 

Create a model file from an existing file in a third-party bar chart application. 

How? 

1. Select New from the File menu and define the project name and other characteristics. 

2. At Stage 1 of the Synchronise Project Wizard select the Change Connection [ ] symbol. 

3. Choose the relevant third-party application from the drop-down list and select OK 

4. At stage 1 of the Primavera Connection Wizard, enter the Primavera username, password 
and database connection and select Test Connection. 

5. Select Next. 
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6. At stage 2 of the Primavera Connection Wizard, select the location in the Primavera EPS 
of the project. 

7. Select Next. 

8. At stage 3 of the Primavera Connection Wizard select Existing and select the project from 
the drop-down list. 

9. Select Finish. 

10. Select Next 

11. At stage 2 of the Synchronise Project Wizard, select In from Primavera Six. 

12. Select Next 

13. At stage 3 of the Synchronise Project Wizard, highlight the changes to make to the 
ADePT model file using the tick boxes – usually leave all changes highlighted. 

14. Select Finish. 

 

2.4 Save the model file you are working on 

Why? 

Commit changes since you last saved the file. 

How? 

1. Select Save from the File menu. 

 

2.5 Save a model file under a new name 

Why? 

Commit changes since you last saved the file and save under a new name. 

How? 

1. Select Save As from the File menu. 

2. Choose the preferred name and location for your file. 

 

2.6 Close a file 

Why? 

Close a project file, either after saving if you wish to re-commence work on it at a later 
stage, or to reject any changes since your last save. 

How? 

1. Select Exit ADePT Design Manager from the File menu.
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CHAPTER 3: DEFINING WORKPLAN SETTINGS  
This chapter describes how to set up the characteristics of a Workplan. 

3.1 Change the project name 

Why? 

Allocate a meaningful name to your project. 

How? 

1. Select Workplan Settings from the Tools group on the Manage Workplans tab. 

2. Enter the project Name by overtyping the current entry. 

3. Click on Close. 

 

3.2 Add or edit responsibilities for planning and m anaging your project 

Why? 

Allocate responsibilities to the key roles associated with management of Workplans in your 
project. 

How? 

1. Select Workplan Settings from the Tools group on the Manage Workplans tab. 

2. Enter the Planner and Manager by overtyping the current entries. 

3. Click on Close. 

 

3.3 Edit the duration of a Workplan’s Focus Period and/or Look-Ahead Periods 

Why? 

Amend the duration of the overall Workplan and the Focus Period in a Workplan to reflect 
reporting periods in your project.  

How? 

1. Select Workplan Settings from the Tools group on the Manage Workplans tab. 

2. Amend the length of the Focus Interval using the up and down arrows. 

3. Amend the number of, and length of, Look-Ahead Intervals using the up and down arrows. 

4. Click on Close. 

More Information 

Updated settings can be applied to a Workplan which is already being worked on, by 
changing the settings and selecting Apply. If the lengths of Focus Interval and/or Look-
Ahead Intervals have been changed then the priority of tasks will change and new tasks may 
appear in the Task Finder. 

 

3.4 Set rules for the steps involved in creating ne w Workplans 

Why? 

Simplify the steps involved in creating new Workplans, or restrict the options available to 
users. 

How? 
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1. Select Workplan Settings from the Tools group on the Manage Workplans tab. 

2. Select Processes from the left-hand menu of the Workplan Settings dialogue box. 

 

3. Select the relevant options related to: 

• Restricting the managing of Workplans; 

• Reviewing settings of new Workplans; 

• Calculating task start and finish dates; 

• Synchronising from third-party planning application; and 

• Saving the project file. 

4. Select Apply. 

More Information 

Restricting the managing of Workplans to a fixed cycle of draft, publish, update and archive 
limits the flexibility of data transfer but means there is only ever one direction in which the 
cycle can progress. The banner at the top of the screen will change to enable this way of 
working. The following sections of this user manual refer to ‘unrestricted’ and ‘restricted’ 
modes.  

 

 

3.5 Set the Format for Exporting Workplans to MS Ex cel 

Why? 

Ensure that, when exporting Workplans to MS Excel so that they can be distributed to team 
members, they are created in the correct location on your computer, that they appear as 
required, and that information on the Workplans is structured as required.  

How? 

1. Set up an Excel template file. A sample template is provided (in C:\Program Files\AML 
Technologies\Adept Design Suite) and it is recommended to use this as a starting point. 
Add, remove or rename column headings, add logos, and amend colours, but do not 
change the layout of the first set of rows in the template which contain the project 
name and dates (the colours can be changed). 
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2. Open the Workplan Settings dialogue by selecting Workplan Settings from the Tools 
group followed by Workplan Distribution. Note that this dialogue can also be opened by 
selecting Export Workplan from the Actions group.  

 

Note that if you have a ‘workplan config’ file associated with version 1.2 of the 
software, the settings within it can be imported by selecting Import Config … at 1. 

3. If necessary, select an alternative MS Excel template at 2.   

4. Identify the location of the desired Outgoing Folder for your Workplans at 3 and 
similarly identify the location of an Incoming Folder at 4. These folders are where 
exported Workplans will be generated prior to distribution to a project team, and 
where returned / completed Workplans must be placed prior to importing changes into 
ADePT Design Manager. 

5. In order for the correct data to appear in the columns of your Workplans the columns 
must be ‘mapped’ to data fields in ADePT Design Manager at 5. This can be done by 

selecting a column heading from the Name list and then selecting the Edit [ ] symbol 
to open the Column Definition Editor. 

 

Select the corresponding data field from the drop down list and whether ADePT Design 
Manager should be writing data out to Excel (e.g. activity names, priority and dates), 
reading in from Excel (e.g. new percent complete and expected completion date), or 
both reading and writing (e.g. note, where the design team may benefit from seeing 
the note added in the last reporting period but you want to capture any new 
comments).  

The image below shows what you expect to see when mapping column headings to data 
fields. Note that some columns in your template may not have corresponding data 
fields in ADePT Design Manager (such as ‘change in %’). The field which corresponds to 
these columns should be left blank. 
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6. To group activities on a Workplan by code types and values (such as WBS) you are 

required to set up groups at 6. Select the Add symbol [ ] and you will be presented 
with the Group Definition Editor dialogue:  

 

To group activities by responsibility (or any other code type) into separate Excel 
workbooks, select Responsibility as the Property and Workbook as the Type in the first 
grouping. All responsibilities can be grouped in the same workbook by selecting All 
under the Values option, or a selection can be grouped into a single workbook by 
selecting Some, however it is recommended that for all grouping the option Every is 
selected so that every code value is represented in its own workbook. 

Add further groupings as required – normally all levels of the WBS starting with level 1, 
then 2, and so on – but ensure that Heading is selected as the Type on all groupings 
except the first (which can be Heading or Workbook). Select an appropriate text and 
cell colour for each grouping, however ensure that where the first grouping is of the 
Type ‘Workbook’ that no colour formatting is applied, since colours can only be applied 
to Headings and not to Workbooks. 
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7. Once all the above steps have been carried out, the settings can be saved by selecting 
Apply.  

 

3.6 Set the Format for Exporting Dashboard Reports to MS Excel 

Why? 

Ensure that the Dashboard is created in the correct location on your computer, that they 
appear as required, and that information transferred to the Dashboard is structured as 
required.  

How? 

1. Set up an Excel template file. A sample template is provided (in C:\Program Files\AML 
Technologies\Adept Design Suite) and it is recommended to use this as a starting point.  

2. Open the Workplan Settings dialogue by selecting Workplan Settings from the Tools 
group followed by Dashboard Publishing. 
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3. Identify the MS Excel template which is required for the project progress information to 
be exported. It is recommended that when first using the Dashboard Publisher that the 
generic MS Excel template is used.  This can then be personalised by the user or 
company to reflect corporate branding or preferred layout and used as a default in 
future. 

4. Select the location which the created Dashboard file will be located (the Outgoing 
folder). 

5. Select Apply. 
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CHAPTER 4: CREATING A WORKPLAN 

This chapter describes how to create a Workplan prior to making it available to the project 
team. 

4.1 Create a new Workplan 

Why? 

Create a new Workplan for the project team, at the start of a Workplan reporting period. 

How? 

1. Select Add New Workplan (or Draft if working in restricted mode) from the Workplan 
group on the Manage Workplans tab. 

2. If progress has been captured ‘out-of-sequence’ then this will be reported on a Progress 
Analysis dialogue box. See 6.4 for a description of resolving out-of-sequence progress. 

More Information 

On the first ever Workplan this will open the Workplan Settings dialogue box; on subsequent 
Workplans it will open a dialogue box prompting a review of the current Workplan Settings. 
Select Yes to review and change settings such as the length of the Workplan focus period or 
No to use the default settings or the settings from the previous Workplan. 

 

4.2 Select tasks for inclusion in a Workplan 

Why? 

Ensure that only the required tasks are included on each Workplan. 

How? 

1. Select Add New Workplan (or Draft if working in restricted mode) from the Workplan 
group on the Manage Workplans tab. If progress has been captured ‘out-of-sequence’ then 
this will be reported on a Progress Analysis dialogue box. See 6.4 for a description of 
resolving out-of-sequence progress. On the first ever Workplan this will open the Workplan 
Settings dialogue box; on subsequent Workplans it will open a dialogue box prompting a 
review of the current Workplan Settings. Select Yes to review and change settings such as 
the length of the Workplan focus period or No to use the default settings or the settings 
from the previous Workplan. 
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2. Review and change settings such as the length of the Workplan Focus Interval or Look-
Ahead Intervals. 

3. Select Close to leave the Workplan Settings dialogue box. 

4. The Calculate Dates dialogue box will ask whether activity dates should be recalculated 
within ADePT Design Manager’s scheduling functionality. Answer Yes or No as required, but 
note that if calculations of activity Float are to be updated then Yes must be selected as 
ADePT Design Manager only reports Float which it has calculated itself and does not read 
Float as calculated by any third party planning application. 

 

5. The Synchronize from External Schedule dialogue box will ask whether ADePT Design 
Manager should read in any new information, such as changes to task dates, which have 
been calculated in a third party planning tool. If you suspect there may have been changes 
in the bar chart select Yes then follow steps 4.1 or 4.2, otherwise select No. 

 

6. The Save Changes dialogue box allows the project to be saved as this key point. Select 
Yes or No as appropriate. 

 

7. Once tasks have been loaded into the Task Finder, select the appropriate selection 
criteria to reveal the tasks that meet those criteria. 

8. Remove any activities which meet your chosen criteria but which you do not wish to add 
to the Workplan by deselecting the activities in the tick box. 
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More Information 

The default Workplan settings are a Focus Period of 14 days and a Look Ahead Period of 2 x 
14 days (28 days in total). 

The selection criteria will default to give activities that are due to be worked on during the 
Workplan period.  

Note that data in the bar chart on which the first Workplan is produced provides a baseline 
against which progress reporting is undertaken. 

When calculating activity start and finish dates, the ADePT Design software assumes that an 
activity with completed predecessors can commence starting on the Project Report Date 
(status date or data date). This same effect is achieved by default when scheduling within 
Asta Powerproject, in Primavera by selecting Progress Override from within the scheduling 
options, and in Microsoft Project by selecting ‘Move End of Completed Parts After Status 
Date Back to Status Date’ and ‘Move Start of Remaining Parts Back to Status Date’ in the 
Calculation tab on the Options dialogue box on the Tools menu. 

 

4.3 Synchronize changes between ADePT Design Manage r and Primavera 

Why? 

Update an existing bar chart with any new changes in the project data captured in ADePT 
Design Manager, or update ADePT Design Manager with changes made in the bar chart. 

How? 

1. Select Synchronize with Plan from the Action/Status group on the Manage Workplans tab. 
If progress has been captured ‘out-of-sequence’ then this will be reported on a Progress 
Analysis dialogue box. See 6.4 for a description of resolving out-of-sequence progress. When 
promoted to send progress to an external schedule, select Yes. 

2. At Stage 1 of the Synchronise Project Wizard, if a synchronisation was undertaken when 
the bar chart file was first created then the same third-party file will be the target of this 
synchronisation – go to step 9. If a different file is the subject of this synchronisation select 

the Change Connection [ ] symbol – go to step 2. 

3. Choose the relevant third-party application from the drop-down list and select OK 
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4. At stage 1 of the Primavera Connection Wizard, enter the Primavera username, password 
and database connection and select Test Connection. 

5. Select Next. 

6. At stage 2 of the Primavera Connection Wizard, select the location in the Primavera EPS 
of the project. 

7. Select Next. 

8. At stage 3 of the Primavera Connection Wizard select Existing and select the project from 
the drop-down list. 

9. Select Finish. 

10. Select Next to move to stage 2 of the Synchronise Project Wizard.  

Note that two checks will be undertaken at this point: firstly the ADePT file will be checked 
for any incompatibility issues such as overly long activity names or illegal characters which 
cannot be handled by the third-party planning tool. In the event that compatibility issues 
are presented in a list, select Apply and then Close to make the suggested changes to your 
ADePT file. 

Secondly, the third-party file will be checked for any incompatibility issues. There cannot 
be any such issues when the third-party plan is initially created but from thereon issues such 
as missing ID numbers will result in a prompt stating that ‘Some Changed to the External 
Plan are Required’. It is recommended that Yes is selected in order to make the changes. 

11. At stage 2 of the Synchronise Project Wizard, select In from Primavera Six or Out to 
Primavera Six depending on which direction changes are being imposed. 

12. Select Next 

13. At stage 3 of the Synchronise Project Wizard, highlight the changes to make using the 
tick boxes – usually leave all changes highlighted. 

14. Select Finish. 

More Information 

ADePT Design Builder version 1.2 can be synchronised with Primavera version 6. Imposing a 
large number of changes on an external file can take a few minutes. 

 

4.4 Synchronize changes between ADePT Design Manage r and Asta 
Powerproject or Microsoft Project 

Why? 

Update an existing bar chart with any new changes in the project data captured in ADePT 
Design Manager, or update ADePT Design Manager with changes made in the bar chart. 

How? 

1. Select Synchronize with Plan from the Action/Status group on the Manage Workplans tab. 
If progress has been captured ‘out-of-sequence’ then this will be reported on a Progress 
Analysis dialogue box. See 6.4 for a description of resolving out-of-sequence progress. When 
promoted to send progress to an external schedule, select Yes. 

2. At Stage 1 of the Synchronise Project Wizard, if a synchronisation was undertaken when 
the bar chart file was first created then the same third-party file will be the target of this 
synchronisation – go to step 5. If a different file is the subject of this synchronisation select 

the Change Connection [ ] symbol – go to step 2. 

3. Choose the relevant third-party application from the drop-down list and select OK 

4. Select Existing Project and select […] to locate the relevant file. 

5. Select OK 



 

 

 
© 2011, Adept Management Ltd Page 16  

 

6. Select Next to move to stage 2 of the Synchronise Project Wizard.  

Note that two checks will be undertaken at this point: firstly the ADePT file will be checked 
for any incompatibility issues such as overly long activity names or illegal characters which 
cannot be handled by the third-party planning tool. In the event that compatibility issues 
are presented in a list, select Apply and then Close to make the suggested changes to your 
ADePT file. 

Secondly, the third-party file will be checked for any incompatibility issues. There cannot 
be any such issues when the third-party plan is initially created but from thereon issues such 
as missing ID numbers will result in a prompt stating that ‘Some Changed to the External 
Plan are Required’. It is recommended that Yes is selected in order to make the changes. 

7. At stage 2 of the Synchronise Project Wizard, select In from Microsoft Project, Out to 
Microsoft Project, In from Asta Powerproject, or Out to Asta Powerproject depending on 
which direction changes are being imposed and the third party application. 

8. Select Next 

9. At stage 3 of the Synchronise Project Wizard, highlight the changes to make to the third-
party file using the tick boxes – usually leave all changes highlighted. 

10. Select Finish. 

More Information 

ADePT Design Builder version 1.2 can be synchronised with Microsoft Project 2003 and 2007 
versions, and Asta Powerproject versions 9 and 10. 

Imposing a large number of changes on an external file can take a few minutes. 

 

4.5 Add selected tasks to a Workplan 

Why? 

Following selection of required tasks in the Task Finder, add them to a new Workplan. 

How? 

1. Following the selection of required tasks in the Task Finder, click Add Selected from the 
Tasks group on the Manage Workplans tab. 
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More Information 

See related help topic: 

4.3 Select tasks for inclusion in a Workplan. 

 

4.6 Remove a task from a draft Workplan 

Why? 

Ensure that only the required tasks are included on each Workplan. 

How? 

1. Select the relevant task and select Remove from the Tasks group on the Manage 
Workplans tab. 

Alternatively; select the relevant task and use the short-cut SHIFT+DELETE. 
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CHAPTER 5: MANAGING A WORKPLAN 

This chapter describes how Workplans are made available to the project team, how progress 
recorded by the project team is captured in a Workplan, and how progress recorded is written 
back to a bar chart. 

5.1 Publish a Workplan to MS Excel 

Why? 

Make an agreed Workplan available for review by project team members and to record 
progress. 

How? 

1. Ensure that in ADePT Design Manager, your project file has a valid Workplan and that a 
Workplan template in MS Excel is available. 

2. Select Export Workplan from the Action group. The Workplan Settings dialogue will 
open. Note that this dialogue can also be opened by selecting Workplan Settings from 
the Tools group followed by Workplan Distribution.  

 

Note that if you have a ‘workplan config’ file associated with version 1.2 of the 
software, the settings within it can be imported by selecting Import Config … at 1. 

3. If necessary, select an alternative MS Excel template at 2.   

4. Identify the location of the desired Outgoing Folder for your Workplans at 3 and 
similarly identify the location of an Incoming Folder at 4. These folders are where 
exported Workplans will be generated prior to distribution to a project team, and 
where returned / completed Workplans must be placed prior to importing changes into 
ADePT Design Manager. 

5. In order for the correct data to appear in the columns of your Workplans the columns 
must be ‘mapped’ to data fields in ADePT Design Manager at 5. This can be done by 

selecting a column heading from the Name list and then selecting the Edit [ ] symbol 
to open the Column Definition Editor. 
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Select the corresponding data field from the drop down list and whether ADePT Design 
Manager should be writing data out to Excel (e.g. activity names, priority and dates), 
reading in from Excel (e.g. new percent complete and expected completion date), or 
both reading and writing (e.g. note, where the design team may benefit from seeing 
the note added in the last reporting period but you want to capture any new 
comments).  

The image below shows what you expect to see when mapping column headings to data 
fields. Note that some columns in your template may not have corresponding data 
fields in ADePT Design Manager (such as ‘change in %’). The field which corresponds to 
these columns should be left blank. 

 

6. To group activities on a Workplan by code types and values (such as WBS) you are 

required to set up groups at 6. Select the Add symbol [ ] and you will be presented 
with the Group Definition Editor dialogue:  

 

To group activities by responsibility (or any other code type) into separate Excel 
workbooks, select Responsibility as the Property and Workbook as the Type in the first 
grouping. All responsibilities can be grouped in the same workbook by selecting All 
under the Values option, or a selection can be grouped into a single workbook by 
selecting Some, however it is recommended that for all grouping the option Every is 
selected so that every code value is represented in its own workbook. 

Add further groupings as required – normally all levels of the WBS starting with level 1, 
then 2, and so on – but ensure that Heading is selected as the Type on all groupings 
except the first (which can be Heading or Workbook). Select an appropriate text and 
cell colour for each grouping, however ensure that where the first grouping is of the 
Type ‘Workbook’ that no colour formatting is applied, since colours can only be applied 
to Headings and not to Workbooks. 
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7. Select Publish to create MS Excel files in the Outgoing folder. Each file will be 
automatically named to contain the date at the end of the Workplan Focus period and 
the grouping code value [DD_Month_Year_CodeValue]. Note that you should not attempt 
to open any exported file until all exported files have been generated. These exported 
files can now be distributed to the project team, for example by e-mail. 

 

5.2 Write captured progress and constraints to a th ird-party plan 

Why? 

Having captured progress, constraints, reasons-for-failure and so on, update the project’s 
bar chart. 

How? 

1. Select Plan from the Action/Status group on the Manage Workplans tab. 

If working in restricted mode, select Archive to Plan from the Stage group on the Manage 
Workplans tab. 

2. The Synchronize to External Schedule dialogue box will ask whether ADePT Design 
Manager should write any new information, such as changes to progress, which have been 
captured. If you wish to update changes in the bar chart select Yes then follow steps 4.1 or 
4.2, otherwise select No. 

 

More Information 
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In unrestricted mode, progress can be written to a planning tool at any time. This allows 
‘what-if’ evaluation to be undertaken so that, for example, the affects of constraints can be 
seen in a plan before accepting the constraint dates. 

 

5.3 View all Workplans 

Why? 

Access previous Workplans to investigate past events 

How? 

1. Select Workplans from the Show group on the Manage Workplans tab. 

2. Double-click on the required Workplan. 

 

5.4 Export the current Workplan or all Workplans to  an MS Excel data table 

Why? 

It can be useful to have the Workplan represented in a file format which is easily reviewed 
by project team members. 

How? 

1. Select Export from the File menu 

2. Choose Export Current Workplan or Export All Workplans. 

3. Select the location and name of the file to be created. 

4. Select Save. 

 

5.5 Remove the current Workplan 

Why? 

Remove all record of the current Workplan. 

How? 

1. Select Remove from the Workplans group on the Manage Workplans tab. 

2. When prompted to remove Workplan, select Yes. 

3. When prompted to confirm the removal of the current Workplan, select OK. 

 

5.6 Reschedule the dates of tasks within the ADePT Design Manager software 

Why? 

Prior to writing captured progress and constraints to a third party plan it may be desirable 
to understand the impact of current progress on specific activities or on the overall plan. 

How? 

1. Select Reschedule Dates from the Tools group on the Manage Workplans tab. 

2. If progress has been captured ‘out-of-sequence’ then this will be reported on a Progress 
Analysis dialogue box. See 6.4 for a description of resolving out-of-sequence progress. 

More Information 

Rescheduling within the ADePT Design Manager software is necessary if reports such as 
overdue days or lateness are to be reported as a result of the current progress. When adding 
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a new Workplan, dates can be synchronised from an external plan so that the dates in the 
new Workplan will be fully aligned with the external plan even if a reschedule has been run 
within the ADePT software. 
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CHAPTER 6: REPORTING ON TASKS IN A WORKPLAN 

This chapter describes how to report on the progress and properties of tasks in Workplan, 
using ADePT Design Manager. Note that the same actions are also able to be performed using 
the ADePT Workplan Distributor. (Please refer to the relevant user manual for detailed 
information) 

6.1 Import a Workplan from MS Excel 

Why? 

Ensure that progress, constraints, and so on, captured in exported Workplans is imported to 
ADePT Design Manager before staring a next Workplan cycle or updating a schedule. 

How? 

1. Gather updated Excel Workplans from the project team and place them in the Incoming 
Folder. 

 

2. Select Import Progress from the Action group. You will be shown how many changes 
need to be applied to the file in ADePT Design Manager, and will be given the 
opportunity to reject any changes by deselecting them from a tick list. 

3. Review the Workplan in ADePT Design Manager and you will see the changes applied to 
the Workplan. 

 

 

6.2 View a summary of the properties of all tasks i n a current Workplan 

Why? 
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Observe all tasks and a summary of all properties in a single view. 

How? 

1. The columns of a Workplan give an overview of key properties. 

2. Select the relevant view from the drop down menu: 

• Progress View – a table showing duration, priorities, dates and progress of tasks. 

• Float View – a table showing the free float, total float and change in float of tasks. 

• Delay View – a table showing overdue days, lateness against baseline dates and 
change in lateness of tasks. 

• Requirements and Constraints View – a table summarising information requirements, 
outputs, reasons for failure and constraints on tasks. 

• Full View – a full table showing all properties of tasks. 

More Information 

As progress on tasks is updated, the number of overdue days is instantly updated. Where the 
expected completed date of a task is changed, the lateness of the task is instantly updated. 
However, overall changes to lateness and float are only calculated when the plan is 
rescheduled (either within ADePT Design Manager when adding a new Workplan or within a 
third party planning tool which then needs synchronising with ADePT Design Manager at the 
time when a new Workplan is added). 

Tasks which have no outstanding Information Requirements and Constraints are shown with 
the ‘Can Do’ status ‘Yes’. Tasks can have a Can Do status No and still appear on a current 
Workplan provided that they have no outstanding Constraints and the only outstanding 
Information Requirements are outputs from tasks which are due to be completed in the 
same Workplan. 

 

6.3 View the properties of a task in a Workplan 

Why? 

Observe the current properties of a task. 

How? 

1. Select the View/Edit Workplan tab and select the relevant task. 

2. Open the Activity [+] option to reveal the required task properties.  

3. Open the Advanced [+] option to reveal the full set of task properties. 
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More Information 

Main task properties are: 

• Name 

• Duration 

• Responsibility 

• Description 

• Effort 

• Activity Category 

• Milestone 

• Project Stage 

 

6.4 Edit the percent complete of a task in a Workpl an 

Why? 

Ensure that the current progress of any task is accurately captured and verified. 

How? 

1. Select the % field of the task in the Workplan and enter the required percentage using 
the up and down arrows or by overtyping the current entry. 

Alternatively; select the relevant task in the View/Edit Workplan tab and enter the required 
percentage using the up and down arrows or by overtyping the current entry. 

More Information 

By importing the updated spreadsheets created by ADePT Workplan Distributor and 
returned from the design team, progress is automatically updated in the workplan when the 
file is re-opened by ADePT Design Manager.  For more on this functionality please refer to 
the ADePT Workplan Distributor user manual. 

6.5 Identify and resolve ‘out-of-sequence progress’  

Why? 
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In certain instances during a project the activities may not follow the predetermined logic 
which was established during the planning phase. Certain successors may actually be able to 
start before the full completion of their predecessors. This is termed ‘out-of-sequence 
progress’. In order for ADePT Design Manager to accurately reflect this scenario in the plan 
certain criteria must be specified. 

How? 

1. Select Reschedule on the View Sequence tab. 

2. If an out-of-sequence scenario exists you will be presented with the ‘Progress Analysis’ 
prompt screen as below: 

 

 
 

3. Depending on the scenario one of several options can be specified:  

• The first option is to ‘Modify activity to be not started’. This option should be 
selected if the selected activity has been misreported or accidentally identified as 
being progressed. The activity is then amended to have 0% progress. 

• If the reporting of progress is correct then the out-of-sequence progress associated 
with the incomplete predecessor needs to be resolved. From the drop down menu 
select the chosen Incomplete Predecessor. Then select one of the resolutions from 
the list. These are described below: 

o Leave unresolved – This option assumes that progress on a successor can in 
fact continue despite the predecessor not being complete. However the 
assumption is that the logic is retained and that there is still an inherent 
link between the two activities. In other words, an early start to the 
successor is allowed but the predecessor must be complete before the 
successor can be fully complete. 

o Modify predecessor to be finished – This option assumes that progress on a 
predecessor has not been updated and it is finished thus allowing the 
successor to proceed. 

o Change dependency to be ‘nice to have’ (tear) – This selection ‘tears’ the 
critical logic link between the two activities and enables the successor to 
continue without full completion of the predecessor. This option would be 
relevant, for example, where an assumption has been made about the 
output from the predecessor. 

o Make part of the predecessor finished and part not started (split) – This 
option assumes that the predecessor can be broken down into two separate 
activities, one of which is required before the successor can start, the other 
being the full completion of the original predecessor. 

• In the last of the above options clicking ‘Apply’ will bring up the Split Activity Editor 
dialogue box where detail about the two activities which are to be formed from 
splitting the single one can be specified. This is completed in the same way as 
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outlined in Chapter 5. It is recommended that the subsequent ‘unprogressed’ part of 
the task is renamed at this stage. Other links which the single activity had prior to 
splitting will be retained on one of the two new activities (with progressed 
successors dependent on the first, completed, new activity and unprogressed 
successors dependent on the second new activity) thus retaining the logic within the 
programme. When a split activity has been specified, select Close. 

 

 
 

4. Select Apply to apply the resolution to the chosen activity or predecessor, or Apply to All 
to apply the chosen resolution to all activities or predecessors. Alternatively, Ignore All can 
be selected to ignore the remaining resolutions, thus leaving them unresolved. 

5. Repeat the above process for the other out-of-sequence activities identified in the 
progress analysis window. 

 

6.6 Edit the expected completion date of a task in a Workplan 

Why? 

Ensure that the expected end date of any task is accurately captured and verified. 

How? 

1. Select the Expected Completion Date field of the task in the Workplan and enter the 
required date using the drop-down calendar. 

Alternatively; select the relevant task in the View/Edit Workplan tab and enter the required 
date using the drop-down calendar. 

More Information 

Changing the expected completion date of a task will automatically update the expected 
duration and the percent complete of the task. The expected duration is the full elapsed 
duration between the task start and finish dates, while the progress is updated to be 
accurate on the date at the end of the focus period based on the expected completion date 
entered. 
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6.7 View or edit the information requirements of a task in a Workplan 

Why? 

Observe the current information requirements of a task, or edit them to ensure that they 
are relevant to the task. 

How? 

1. Select the relevant task in the View/Edit Workplan tab. 

2. Open the Information Requirements [+] option.  

3. Select the required information requirement and select Edit from the Requirements group 
on the View/Edit Workplan tab 

Alternatively; right-click on the relevant information requirement and select Edit. 

Alternatively; select the relevant information requirement and use the short-cut F2. 

4. Amend the properties of the information requirement as required. 

5. Click OK. 

More Information 

See related help topics: 

6.6 Tear a task’s information requirement. 

 

6.8 Tear a task’s information requirement 

Why? 

Tearing an information requirement allows the task to proceed without being affected by 
any delay in the preceding task which creates the information. A decision / assumption 
about the information requirement would be required. 

How? 

1. Select the relevant task in the View/Edit Workplan tab. 

2. Open the Information Requirements [+] option.  

3. Select the required information requirement and select Edit from the Requirements group 
on the View/Edit Workplan tab 

Alternatively; right-click on the relevant information requirement and select Edit. 

Alternatively; select the relevant information requirement and use the short-cut F2. 

4. Select the tick box under the Tearing section and enter an explanation for the tear, 
which is normally a description of the decisions / assumptions which are required as a result 
of the tear. 

5. Click OK. 
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More Information 

See related help topics: 

6.5 View or edit the information requirements of a task in a Workplan. 

 

6.9 View or edit the outputs of a task in a Workpla n 

Why? 

Observe the current outputs of a task, or edit them to ensure that they are relevant to the 
task. 

How? 

1. Select the relevant task in the View/Edit Workplan tab. 

2. Open the Outputs [+] option.  

3. Select the required output and select Edit from the Outputs group on the View/Edit 
Workplan tab 

Alternatively; right-click on the relevant information requirement and select Edit. 

Alternatively; select the relevant information requirement and use the short-cut F2. 

4. Amend the status of the output as required. 

5. Click OK. 

 

 

6.10 Add a constraint to a task which is shown on a  Workplan as due in a future 
Focus Period 

Why? 
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Where tasks have known constraints which mean they cannot currently be undertaken then 
indicate the constraint on the Workplan. 

How? 

1. Select the relevant task in the View/Edit Workplan tab. 

2. Open the Constraints [+] option. 

3. Select Add from the Constraints group on the View/Edit Workplan tab. 

Alternatively; click on the Constraints section and use the short-cut INSERT. 

4. Select the constraint Type from the drop-down list and add a Description. 

5. Assign the date when the constraint is Expected to be removed and indicated whether 
the constraint should be automatically removed on the date using the tick box. 

6. Click OK. 

 

More Information 

Constraints should be added to tasks which are due to be completed in a future Focus 
Period. Tasks which are due to be completed in a current Focus Period but which are not 
able to be completed should have a reason-for-failure assigned rather than a constraint. 

See related help topics: 

6.11 Indicate that a constraint which is assigned to a task has been ‘removed’ 

6.12 Confirm that a task’s timing is not to be affected by a constraint (‘work at risk’). 

 

6.11 Add new types of constraint to a project 

Why? 

Add types of constraint so that these can then be assigned to activities as required. 

How? 

1. Select Workplan Settings from the Tools group on the Manage Workplans tab. 

2. Select Constraint Types from the menu on the left-hand side of the dialogue box. 

3. Select Add and enter the name of the new Constraint. 

4. Select Close. 

More Information 

See related help topics: 

6.13 Add new types of reason-for-failure to a project. 
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6.12 Delete a constraint which is assigned to a tas k 

Why? 

Where a constraint has been inaccurately assigned to a task, remove it before publishing the 
Workplan. 

How? 

1. Select the relevant task in the View/Edit Workplan tab. 

2. Open the Constraints [+] option. 

3. Select the relevant constraint and select Remove from the Constraints group on the 
View/Edit Workplan tab. 

Alternatively; right-click on the relevant constraint in the Constraints section and select 
Remove. 

Alternatively; right-click on the relevant constraint in the Constraints section and use the 
short-cut SHIFT+DELETE. 

More Information  

Note that a constraint can only be deleted before the Workplan is published. 

 

6.13 Indicate that a constraint which is assigned t o a task has been ‘removed’ 

Why? 

Where tasks have had constraints allocated but these constraints have been removed, 
indicate this on the Workplan to ensure the tasks are shown as able to be undertaken. 

How? 

1. Select the relevant task in the View/Edit Workplan tab. 

2. Open the Constraints [+] option. 

3. Select the relevant constraint and select Edit from the Constraints group on the 
View/Edit Workplan tab. 

Alternatively; right-click on the relevant constraint in the Constraints section and select 
Edit. 

Alternatively; right-click on the relevant constraint in the Constraints section and use the 
short-cut F2. 

4. Confirm that the constraint has been removed using the tick box and entering the Actual 
date. 

5. Enter details of the Resolution which has allowed the constraint to be removed. 

6. Click OK twice. 

 



 

 

 
© 2011, Adept Management Ltd Page 32  

 

More Information 

Note that constraints are not deleted, but that when a constraint has been removed it is 
given that status so that a record of its existence is maintained. 

See related help topic: 

6.12 Confirm that a task’s timing is not to be affected by a constraint (‘work at risk’). 

 

6.14 Confirm that a task’s timing is not to be affe cted by a constraint (‘work at 
risk’) 

Why? 

Undertaking an activity despite a known constraint allows the task to proceed without being 
affected by any delay while the constraint is removed. A decision / assumption about the 
constraint would normally be required. 

How? 

1. Select the relevant task in the View/Edit Workplan tab. 

2. Open the Constraints [+] option. 

3. Select the relevant constraint and select Edit from the Constraints group on the 
View/Edit Workplan tab. 

Alternatively; right-click on the relevant constraint in the Constraints section and select 
Edit. 

Alternatively; right-click on the relevant constraint in the Constraints section and use the 
short-cut F2. 

4. Select the tick box under the Work at Risk section and enter an explanation, which is 
normally a description of the decisions / assumptions which are required. 

5. Click OK. 

 

 

6.15 Add a reason-for-failure to a task in a Workpl an 

Why? 

Where a task was due to be completed in the current Workplan Focus Period but it has not 
been able to be completed, ensure that the reason is recorded. 

How? 

1. Select the relevant task in the View/Edit Workplan tab. 

2. Open the Reasons-for-Failure [+] option. 
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3. Select the relevant reason-for-failure and select Add from the Reasons-for-Failure group 
on the View/Edit Workplan tab. 

Alternatively; select the Reasons-for-Failure section and use the short-cut INSERT. 

4. Select the reasons-for-failure Type from the drop-down list and add an Explanation. 

5. Describe any Planned Remedial Action which is identified as necessary to correct the 
failure. 

6. Click OK. 

 

More Information 

A reason-for-failure can only be added to a task which was due for completion in the current 
Focus Period. 

See related help topics: 

6.15 Edit a reason-for-failure which is assigned to a task. 

 

6.16 Add new types of reason-for-failure to a proje ct 

Why? 

Add types of reason-for-failure so that these can then be assigned to activities as required. 

How? 

1. Select Workplan Settings from the Tools group on the Manage Workplans tab. 

2. Select Constraint Types from the menu on the left-hand side of the dialogue box. 

3. Select Add and enter the name of the new Reason-for-Failure. 

4. Select Close. 

More Information 

See related help topics: 

6.9 Add new types of constraints to a project. 

6.17 Edit a reason-for-failure which is assigned to  a task 

Why? 

Where tasks have had reasons-for-failure allocated, ensure that these are accurately 
assigned. 

How? 

1. Select the relevant task in the View/Edit Workplan tab. 

2. Open the Reasons-for-Failure [+] option. 

3. Select the relevant reason-for-failure and select Edit from the Reasons-for-Failure group 
on the View/Edit Workplan tab. 

Alternatively; right-click on the relevant reason-for-failure in the Reasons-for-Failure 
section and select Edit. 
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Alternatively; right-click on the relevant reason-for-failure in the Reasons-for-Failure 
section and use the short-cut F2. 

4. Amend the reason-for-failure as required. 

5. Click OK. 

More Information 

See related help topics: 

6.13 Add a reason-for-failure to a task in a Workplan. 

 

6.18 Add notes associated with a task in a Workplan  

Why? 

Record notes or comments against a task in a Workplan.  

How? 

1. Select the relevant task in the View/Edit Workplan tab. 

2. Select Add from the Notes group on the View/Edit Workplan tab. 

Alternatively; open the Notes section [+] and use the short-cut INSERT. 

3. Type the details of the note to add. 

4. Click OK. 

 

 

6.19 Remove a note associated with a task in a Work plan 

Why? 

Remove superseded notes or comments which have been recorded against a task in a 
Workplan.  

How? 

1. Select the relevant task in the View/Edit Workplan tab. 

2. Open the Notes [+] option and select the relevant note. 

3. Select Remove from the Notes group on the View/Edit Workplan tab. 

Alternatively; right-click on the relevant note and select Remove. 

Alternatively; select the relevant note and use the short-cut SHIFT+DELETE. 

 

6.20 Update the project baseline 

Why? 

Change the baseline dates on some or all of the activities in a project so that performance 
is measured against an up-to-date baseline.  
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How? 

1. Select Reset Baseline from the Update group on the Analyse Progress tab. 

2. Select one of the following: 

� Only New Activities (to set the baseline date on activities which have been added to the 
project since the baseline was first set) then Finish. 

� All Activities (to reset the baseline on all activities) then Finish. 

� A Selection of Activities (to be given the choice of which activities to reset the 
baseline) and then Next. 

3. Where A Selection of Activities is chosen, select the relevant activities to have their 
baseline dates reset using the WBS tree view, and then select Finish. 
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CHAPTER 7: REPORTING ON PROJECT PROGRESS 

This chapter describes how reports on progress and performance are generated. 

7.1 Exporting a Dashboard Report to MS Excel 

Why? 

Create a visual Dashboard of project status. 

How? 

1. Select Publish Dashboard from the Action group. Note that if no outgoing folder is 
selected, in which to generate the dashboard, a warning message will be shown and 
OK should be selected. 

 

2. The Workplan Settings dialogue will open and Dashboard Publishing should be selected. 

 

 

3. Identify the MS Excel template which is required for the project progress information to 
be exported. It is recommended that when first using the Dashboard Publisher that the 
generic MS Excel template is used.  This can then be personalised by the user or 
company to reflect corporate branding or preferred layout and used as a default in 
future. 

4. Select the location which the created Dashboard file will be located (the Outgoing 
folder). 

5. Select Apply and the Dashboard file will be produced. Note that this may take some 
time depending on the amount of data being exported. When the export is completed, 
a message confirming the export will be shown. 

 

6. Open the MS Excel dashboard file from the chosen ‘Outgoing’ folder. 

7. Note that the default dashboard template provided contains pivot tables, and these 
require refreshing in MS Excel. 
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7.2 View tabular or graphical reports of the projec t team’s progress 

Why? 

Understand the progress that the overall project team is making, and that of each team 
member individually, in complying with the project plan. 

How? 

1. Select Task Progress from the Analysis group on the Analyse Progress tab. 

2. Select the required Report using the drop-down list on the Subject group. 

• Percent Planned Complete in the current Workplan period – performance in 
completing tasks in the focus period. 

• Work in Progress in the current Workplan period - performance in progressing tasks 
in the focus period. 

• Overall (cumulative) Percent Planned Complete - performance in completing tasks 
over the life of the project. 

• Overall (cumulative) Work in Progress - performance in progressing tasks over the 
life of the project. 

• Overall progress – the proportion of days completed compared to the proportion on 
the baseline plan at the same time. 

• Overdue days – the number of outstanding days at each point over the life of the 
project. 

• Projected project length – the overall duration of the project. 

3. Select the responsibility to report for using the drop-down list on the Subject group. 

4. Select the required report format by selecting Table or Chart from the Output group. 

 

 

7.3 View tabular or graphical reports of the progre ss in the project against a 
baseline 

Why? 
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Understand the overall progress of the project against the original (baseline) plan. 

How? 

1. Select Baseline v Actual from the Analysis group on the Analyse Progress tab. 

2. Select the required Report using the drop-down list on the Subject group. 

3. Select the required report format by selecting Table or Chart from the Output group. 

 

 

More Information 

Note that baseline curves are created from data in the bar chart on which the first Workplan 
is produced. 

 

7.4 View tabular or graphical reports of constraint s on tasks in Workplans 

Why? 

Gain an overview of current task constraints and trends in the types/numbers of constraints 
throughout the project. 

How? 

1. Select Constraints from the Analysis group on the Analyse Progress tab. 

2. Select the required Report using the drop-down list on the Subject group. 

3. Select the required report format by selecting Table or Chart from the Output group. 

 

7.5 View tabular or graphical reports of task failu res in Workplans 

Why? 

Gain an overview of current task failures and trends in the types/numbers of failures 
throughout the project. 

How? 
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1. Select Reasons-for-Failure from the Analysis group on the Analyse Progress tab. 

2. Select the required Report using the drop-down list on the Subject group. 

3. Select the required report format by selecting Table or Chart from the Output group. 

 

 

7.6 Export a tabular report to MS Excel 

Why? 

Export tabular reports so that they can be manipulated in MS Excel. 

How? 

1. Generate the required tabular report from the Analyse Progress tab. 

2. From the File menu select Save Analysis As ... 

3. Select the file name and location of the exported table. 

4. Select Save. 

More Information 

Note that data can also be exported to MS Excel documents to allow distribution to the 
project team via use of ADePT Workplan Distributor.  MS Excel documents created in this 
manner can also be read back into the programme when they are updated in order to simply 
update the plan. 

For more information please refer to the ADePT Workplan Distributor user manual. 

 

7.7 Export a graphical report as an image 

Why? 

Export graphical reports so that they can be viewed as images. 

How? 

1. Generate the required graphical report from the Analyse Progress tab. 
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2. From the File menu select Save Analysis As ... 

3. Select the file name and location of the exported graph. 

4. Select the required file type from the drop-down menu. 

5. Select Save. 

 

7.8 Preview and print a tabular or graphical Report  

Why? 

Generate a printed report of a table or graph of progress, constraints or reasons for failure. 

How? 

1. Select Print from the File menu. 

2. Select the relevant report to print. 

 

3. Adjust printer and page settings by selecting Page Setup from the toolbar at the top of 
the preview window. 

 

4. Select Print from the toolbar at the top of the preview window. 

5. Select OK. 
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More Information 

Reports can be saved in a number of formats, such as PDF, HTML, MS Word and image files. 
To do this, select Save from the toolbar then select from the Save as Type drop-down menu. 


